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Learn LISP, Start Creating
Previously, our intrepid CAD Manager

was searching for the famed “LISP of 
the AutoCAD,” an elusive program that
contains magical powers for those who
wield it. The program was described as
being fewer than 30 lines long, in a 
foreign code known as AutoLISP. Few
individuals today can harness the power
therein contained since few have mastered
its “parenthetic” overtones. But those that
have tried to learn its secrets have typical-
ly succeeded and gone on to greatness
never before imagined…

<Loud and momentous music plays in
the background>

“CUT! Get real, Dave!” Ok, ok, sure—
spoil my fun. But I think AutoLISP pro-
grams are great! You should think so, too!
You are probably using AutoLISP pro-
grams every day and don’t even know it.
And you know what? Nearly every decent
command in AutoCAD at one time WAS
an AutoLISP program. Someone wrote it
up to help them with some daily task. They
then shared it with coworkers, the ones
they liked anyway. Then one of these
‘friends’ was a true friend and stole the
program when he quit! Once on the out-
side, this little LSP gained new popularity
as it was shared amongst the multitudes on
CompuServe and later the Internet and
newsgroups. It had a new lease on life.

Then one day, after shipping the latest
big R, some Autodesk product manager
stumbled upon the program while ponder-
ing what to do next with AutoCAD.
“Hmmmm,” he said. “Looks like easy pick-
ing fruit.” Suddenly, teams of program-
mers downloaded the long forgotten pro-
gram, analyzed its inner workings, consid-
ered its uses and how much it would cost.
Cost? Yes! For they can make it better than
before. Way more powerful and robust,
with lots more lines of code and lots of

options. And in a different language alto-
gether! They can truly make it THEIRS.
And then sell it! Hehe.

Ahhh, programming is a beautiful thing,
isn’t it? But it all started that one day when
Hugh Ringling needed a way to tweak his
hatch pattern. He wanted it to be more
distinctive, to have more personality. So
often when he hatched, the patterns he
created seemed to blend into a mass of
lines and dots—BLAH and UGLY! His
drawings are not just a way to convey how
to build something, they are an art form in
their own right! They must be better look-
ing—or at least more fun to draw! That
would compensate nicely.

Enter stage left—the AutoLISP pro-
gram DYNAMIC HATCH. It can easily
take your plain vanilla-flavored hatch and
create unique, one-of-a-kind patterns,
never to be duplicated again in nature!
More powerful than slinging paint on a
wall with a brush, Dynamic Hatch (DH for
short) allows you to create custom one-off
hatch objects. You will never have as much
fun again creating hatch. Here is your
chance to be creative! Go nuts! Break 
out of your CAD shell, so to speak. It’s
time to create a bit of chaos in that
superbly accurate 16 decimals drawing of
yours (see box below).

The Cad
David Harrington

Manager

(defun c:DH (/ old_cmd old_osm old_dyn IPT PNT HSC HAN V2006 *error*)
(princ “\nDYNAMIC HATCH”)
(setq old_cmd (getvar “cmdecho”))
(setq old_osm (getvar “osmode”))
(if (>= (atof (getvar “acadver”)) 16.2)
(setq V2006 T old_dyn (getvar “dynmode”)))

(defun *error* (strerr)
(setvar “cmdecho” old_cmd)
(setvar “osmode” old_osm)
(if V2006 (setvar “dynmode” old_dyn))

(princ))
(setvar “cmdecho” 0)
(setvar “osmode” 0)
(if V2006 (setvar “dynmode” 0))
(command “undo” “be”)  
(setq IPT (getpoint “\nPick internal point of boundary to be hatched: “))
(command “_bhatch” “a” “a” “y” “” “p” “” “1” “0” IPT “”)
(prompt “\nMove mouse to adjust scale and angle <left click to accept>: “)
(while (/= (car PNT) 3)

(setq PNT (grread 1 15 0))
(if (= (car PNT) 5)

(if (/= (distance IPT (cadr PNT)) 0)
(progn
(setq HSC (/ (distance IPT (cadr PNT)) 2))
(if (< HSC 0.125) (setq HSC 0.125))
(setq HAN (angtos (angle IPT (cadr PNT)) 0 1))
(command “-hatchedit” “last” “p” “” HSC HAN)))))

(command “undo” “e”)
(setvar “cmdecho” old_cmd)  
(setvar “osmode” old_osm)
(if V2006 (setvar “dynmode” old_dyn))
(princ)
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In Figure 1, you can see a sample of the
POWER of Hugh’s creation. These two
very different hatch patterns were created
with just two presses of a toolbar button
and four clicks on screen! How’s that for
speed? Notwithstanding all the time I was
playing with the dynamic hatch genera-
tion...but I only clicked my mouse six
times! Now the program will use the
default HATCH settings for the pattern,
whereas the scale and angle are controlled
during the program’s use. To use a specific
pattern without first creating a hatch
object, change the HPNAME system vari-
able to whatever you need. You can even

put this into a toolbar button with some-
thing like what is below. Of course, the
program needs to be placed on your
AutoCAD search path.
^C^Csetvar;hpname;earth;(load”DH”);DH

Share your stuff
I want to extend a big thank you to the

readers who sent in their programs and
enhancements for this article. Even
though I could not use yours here, I’m
sure others will find your concepts help-
ful. But you need share them! Hit the
AUGI Forums and AUGI Exchange to
give and take from the user community at
large. There are so many tools out there;
something is bound to be helpful to you.
Many of the user-provided tools of today
will show up later in AutoCAD itself.
This just makes room for more freebies,
of course. If you don’t know how to pro-
gram in LISP, do yourself a favor and
learn! Start and complete a tutorial, take
an online course, AUGI Training
Program (ATP), read a book, follow the
garden path, and attend Autodesk
University. Improve, improve, have fun,
improve, improve...

David Harrington,technical editor for AUGIWorld,
works for Walter P. Moore and Associates in
Tampa, Florida, USA. David is the author of Inside
AutoCAD 2005, Inside AutoCAD 2002, and origi-
nal programmer for REVCLOUD. He can be
reached at david.harrington@augiworld.com.Figure 1

You will never have as
much fun again creating
hatch. Here is your 
chance to be creative! 
Go nuts! Break out of your
CAD shell, so to speak.



Education
& Training

It’s all about learning
It’s fall and it’s back to school time.

Even though most of us are past
the age of returning to school,
September is still a great
reminder that for us to
reach a higher level pro-
fessionally we must
constantly seek more
knowledge and skills. 

Last issue we
addressed learning styles
with the help of Eugene Evon from
Autodesk. What has also been brought to
my attention, from readers’ emails as well
as from colleagues at a recent Autodesk
Training Center Advisory Board meeting,
is that there are clear stages of learning—
unconscious incompetence through
unconscious competence. I was so
intrigued by these stages I thought I would
do a little research on it so we could all
have a better understanding of how we
learn and become more productive. 

Stages of learning 
The conscious competence model

explains the process and stages of learning
a new skill. It is a useful reminder that we
learn in stages.

As learners or trainees, we can find our-
selves in one or more of these stages at any
time in our professional careers. Let me
begin by outlining the four stages and how
we move from one stage to another.

1 – Unconscious
Incompetence 
• The person is not aware of the existence

or relevance of the skill area. 
• The person is not aware that he or she

has a particular deficiency in the area
concerned. 

• The person might deny the relevance or
usefulness of the new skill. 

• The person must become conscious of
his or her incompetence before devel-
opment of the new skill or learning 
can begin. 
How would you know you needed 

training to improve your skills to become
more productive if you were operating in a
state of unawareness? You’re going to need
an open mind as you approach new skills
and elements. “You don’t know what you
don’t know” has been our mantra for the
AUGI CAD Camps (www.cadcamp.com).
Are these events full-bore training? Of
course not. But they are more than just
awareness sessions: in five 75-minute ses-
sions during the course of a day you’ll gain
productivity techniques you’ll be able to
apply immediately. You’ll soon realize how
much you don’t know and will want to
move to stage 2.

2 – Conscious
Incompetence 
• The person becomes aware of the exis-

tence and relevance of the skill. 
• The person is, therefore, also aware of

his or her deficiency in this area, ideally
by attempting or trying to use the skill. 

• The person realizes that by improving
skills or abilities in this area, effective-
ness will improve.

• Ideally the person has a measure of the
extent of his or her deficiency in the rel-
evant skill, and a measure of what level of
skill is required to achieve competence.
This is what I like to refer to as the “a-

ha” principle. Now you know there’s more
out there. This is where you should begin
to seek out a complete training program,
through Autodesk Training Centers and
other professional-quality training
providers that understand the product and
industry in which you need training. I’ve
covered how to obtain traditional training
as well as process-based training in my
previous education articles.

3 – Conscious Competence 
• The person achieves “conscious compe-

tence” in a skill when he or she can per-
form it reliably at will. 

• The person will need to concentrate and
think in order to perform the skill. 

• The person can perform the skill with-
out assistance. 

• The person will not reliably perform the
skill unless thinking about it—the skill is
not yet “second nature” or “automatic.”

• The person should be able to demon-
strate the skill to another, but is unlikely
to be able to show mastery of it. 
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• The person should ideally continue to
practice the new skill, and, if appropri-
ate, commit to becoming “unconscious-
ly competent” at the new skill. 
People who do not practice and apply

the new skill will soon revert to the old
methods and techniques with which they
are most comfortable. I have seen this over
and over again. The single most effective
way to move from stage 3 to 4 is the com-
mitment to learn and practice the new
skill, and to move to the “unconscious
competence” stage. 

4 – Unconscious
Competence 
• The skill becomes so practiced that it

enters the unconscious parts of the
brain—it  becomes “second nature.”
Common examples are driving, sports
activities, typing, and manual and other
dexterity tasks. 

• It becomes possible for certain skills to
be performed while doing something
else, for example, knitting while reading
a book. 

• The person might now be able to teach
others the skill concerned, although

after some time of being unconsciously
competent, the person might actually
have difficulty in explaining exactly how
to do it—the skill has become largely
instinctual.
This is the goal we seek in every task,

every new skill, every activity at which we
desire to excel. It is our goal with using
Autodesk software as well. This also gives
rise to the need for long-standing uncon-
scious competence.  

With every new release of the software,
there is always an element of all four stages
of the conscious competence model. For
example, there may be features with which
you aren’t familiar. You will be in the
unconscious incompetence stage when you
encounter them. Conversely, there almost
certainly will be a tool you know from a
previous release. Your interaction with this
tool will probably be at a level of conscious
or unconscious competence, depending on
your existing skill with the tool.

As you approach a new version of the
software, or any learning opportunity for
that matter, be aware of the conscious
competence model. It might be helpful to
be thinking of the first stage as you install

the software: most people use it in exactly
the same way as the old version, complete-
ly unaware of or, even worse, ignoring the
new features. If you are particularly sensi-
tive to the concept of unconscious incom-
petence, you should open the “New
Features Workshop” dialog box and
increase your awareness of unfamiliar pro-
ductivity features. Then open the new dia-
log boxes and try the new commands so
that you are exposed to unfamiliar ele-
ments. Remember, you don’t know what
you don’t know. Strive for the conscious
competence level through training and
practice to take your skills to the next level.

I hope this learning model will be help-
ful to you as you consider your profession-
al knowledge and skills. Until next time,
keep that dialog box open!

Matt Murphy, chair of the Autodesk
Training Center Advisory Board (ATCAB), is
an Autodesk Certified Instructor (ACI). He
teaches AutoCAD productivity seminars at
ATCs, Autodesk University, AUGI CAD Camps,
and private companies. He can be reached
at matt.murphy@ACADventures.com.
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The release of Autodesk® Architectural
Desktop 2006 brought several new fea-
tures to our fingertips. Display themes is
one of those new and exciting features that
can greatly help our productivity and sim-
plify the display system. 

Display themes is a tool that you can use
to incorporate non-graphical data in your
drawings, both 2D and 3D, based on prop-
erty set data.  This is done by using fills,
hatches, and colors to highlight objects in
plan view that meet the criteria that you
have established in a display theme style.
Display themes is a feature that will work
with any Architectural Desktop object you
have created. 

Display themes can be used for many
purposes.  For example, you can use them
to highlight fire-rated walls, such as in Life
Safety plans, or to show area plans by size
or by occupancy.  

Let’s take a look at how to create a new
display theme.

Creating display themes
There is a simple five-step process that

you can follow to create a display theme:
1. Create property data formats that you

will use in your theme.  The formats that
you create will determine how your data
is displayed in the display theme legend.

2. Create property set definitions for
objects in your drawing.  Here you will
incorporate formats from step 1.

3. Create a display theme style.  This will
specify the format for the legend of your
display theme as well as what objects
will be highlighted in your drawing.  The
legend is a key that will incorporate
property set definitions from step 2.  It
will specify which visual indicator will be
applied to which objects in a drawing
and what the content will be.

4. Attach property set data to the objects
for inclusion in your display theme.

5. Activate the display theme by adding
the legend to the drawing.
Now, let’s look at each of these steps in a

little more detail.

Property data formats
Property data formats are created and

edited in the Style Manager under the
Format menu.  To create a new one, expand
Documentation Objects, right-click Property
Data Formats, and click new.  Enter a name
for the new format and click enter.

Now, you will want to click on the
Formatting tab (see Figure 1).  Here, 
you will need to specify how you wish 
the formatting to appear.  Fill in all infor-
mation pertinent to the format you 
are creating.

Figure 1

Figure 2

Creating Display 
Theme Styles
Take a closer look at an exciting new feature 
in Autodesk Architectural Desktop

A U T O D E S K
H O W  T O

G U I D E
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Property set
definitions

Property set definitions
are created and edited in
the Style Manager under
the Format menu.  To cre-
ate a new one, expand
Documentation Objects,
right-click Property Set
Definitions, and click new.
Enter a name for the new
definition and click enter.

Now you will want to
click on the Definition tab
(see Figure 2) and add
Property definitions as needed.

Display theme styles
Display theme styles are created and edit-

ed in the Style Manager under the Format
menu.  To create a new style, expand
Documentation Objects, right-click Display
Theme Styles, and click new.  Enter a name
for the new definition and click enter.  You
can then enter a description if you like.

Next, click on the Design Rules tab (see
Figure 3) and click the button to create a
new theme setting.  This will create an
unnamed theme setting with an index num-
ber of one.  Now you can create the settings
for the display theme, which will control the
type of highlighting in the style.

Next, you can create theme rules for each
theme setting, which will determine specifi-
cally which objects will be highlighted using
each setting.  When you create a theme rule,
you will see an index number, which corre-
sponds with the theme setting.  If you wish,
you can create multiple rules for each theme
setting.  For each theme rule you create, you

can select a property set
definition, a property,
which is contingent upon
the property set definition
you selected, and a condi-
tion,  which is contingent
upon the property set defi-
nition and property you
selected.  Then you will
enter a value appropriate to
the condition you selected
and select an operator
appropriate to the formula
you are creating for the
theme rules.

Next, you will specify the
format for the design theme legend by
clicking on the Legend Format tab.  Enter
in the information that is pertinent to 
your style.

Last, you will specify the display proper-
ties for the display theme legend by clicking
on the Legend Display Properties tab.  You
will then select the display representation on
which to display the changes and select the
Style Override.  The display representation
in bold is the current display representation.
Click the Layer/Color/Linetype tab, select
the component to change, if any, and select
a different setting for the property.

Once your display theme style is created,
you can drag and drop it onto the tool
palette for future use.  Doing this creates a
display theme tool.  Once it is placed on the
tool palette, you can right-click on it and
click on properties to add a description,
change the scale of the legend, etc.

Attach property set data
Now that you have created everything

you need for your display theme, you will

need to attach property set data to objects in
your drawing.

Double-click the objects to which you
will be attaching property set data.  On the
Properties Palette, click the Extended
Data tab (see Figure 4).  Next, click the
button at the bottom of the palette to add
property sets.  Select the property sets to
attach to the object and click ok.

The property set is now attached.  You
will find that the values for automatic
properties are already filled in.  At this
point, you can enter data for manual prop-
erties for each object. 

Activate display theme
At this point, you are ready to add the

theme into your drawing.  The display
theme is added to the drawing through
either the scheduling tool palette or the
command DisplayThemeAdd.

Open the tool palette that contains the
display theme tool you want to use and
select the tool.  In the drawing area, spec-
ify the insertion point for the upper-left
corner of the display theme legend.  Then
specify the lower-right corner of the leg-
end or press enter to scale the display
theme legend to the current drawing scale.
The display theme is now activated.  At
this point, you will notice that the objects
affected by the display theme visually
change in the drawing as indicated by 
the legend.  

You can add more than one display
theme to your drawing, however; only one
theme at a time can be active.  If you add
a display theme to a drawing and there is
already a display theme there, the older
one will automatically be disabled when
you add the new one.  If new data is added
to your drawing that meets the criteria of
your display theme style, it will be added
to the legend.

Conclusion
After creating your first display theme,

you will notice at each use that inserting a
display theme style in a drawing is a lot
quicker than inserting hatches and color
fills separately for each object in a large
drawing.  With tools such as this at my fin-
gertips, I can’t wait to see what Autodesk
comes up with next!

Melinda Heavrin is a CAD
Coordinator for Norton
Healthcare in Louisville,
Kentucky. She can be
reached for comments and
questions at melinda-
heavrin@alltel.net.

Figure 3

Figure 4
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“Draw to scale!” was a demanding
instruction given to beginners in manual
drafting. Therefore, it isn’t too surprising
that some try to continue that practice
when making the transition to AutoCAD®.
Even some AutoCAD books suggest con-
sidering scale in model space by saying
“draw at 1:1 scale,” which is another way of
saying draw in true dimensions.

Most will recognize that if they are
drawing the outline of a 10 foot by 12 foot
room, the displayed entity can’t actually be
10' by 12'! So this entity must be scaled to
fit the screen, correct? Yes, but the
AutoCAD software will scale the display
using several perimeters that you supply.

A more accurate expression would 
be enter actual dimensions and the soft-
ware will choose the appropriate scale to
use in the display and store the actual
dimensions in its database. When ready to
plot, you will be given the opportunity to
choose the appropriate scale for plotting.
By a few examples in this article, I will
illustrate how AutoCAD handles scaling
for you, which is intended to make the
process simpler. 

The first scaling action by AutoCAD
occurs when you enter your dimensions
(i.e., a 40' by 20' foundation). You can tell
immediately that scaling must occur since
your display is at most a 19," 21," or 24"
diagonal screen. 

STEP-BY-STEP Exercise 1
1. Set the units to Architectural
2. Set the limits to 60' by 40' ––> first

parameter that you choose
3. Zoom all ––> second parameter that

you chose
4. Beginning at 10', 10' draw 40' line. (sug-

gest using @40'<0 for second point)

5. Measure the line on the screen with a
ruler. (Mine measured 5-1/2”). So now
the scale used was 480"/5.5" or 1" to
87.25" ( 1" to 7'-3.25")

6. To illustrate that
database still con-
tains 40', use the
dist command at
the command line
and you should find
the x distance to be
40'. 

7. Another method to
check is to enter at
the command line:
(entget (entlast))

Look at the dotted pair 10 on the text
screen and you will see something like
this:  10. 120.0 120.0 (the coordinates
of the beginning
of the line)

Look at the
dotted pair 11
and you will see
something like
t h i s — 6 0 0 . 0
120.0 0.00 (the
coordinates of
the end of the
line. Realize that
these numbers
are inches [600 –
120]/12 = 40')

Step 7 might be
unfamiliar to you,
but it is another way
to duplicate step 6
by using the entity data.

So we have illustrated with two different
methods that the software has scaled for
you and now we will see where the user is
asked to scale the line for plotting.

STEP-BY-STEP Exercise 2
With the same units and limits, draw 

a 40' by 20' foundation 6" wide (see 
Figure 1). 

To illustrate the scaling function, we will
use File>Plot route.  This should show a
display similar to Figure 2.

You should check three items in this dis-
play as enumerated in the figure:
1 ––>Plot device: (I was using a printer but
had failed to indicate this before capturing
this figure.) 2 ––>Paper Size: ( I was using
letter size), and most important

For Novices Only
New to AutoCAD? 
Here are some timely tips

Figure 1

Figure 2

“Draw to scale!” was a demanding instruction given
to beginners in manual drafting.
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3 ––>Plot scale: (When clicking the down
scroll arrow, you should see Figure 3.)

Now this is where choosing the correct
scale is important. What is the longest
dimension of the foundation drawing? 40'.
And what is the longest dimension of the
printable area? 10.5". So we must choose a
scale which will allow us to place the 40'
into the 10.5". If we choose 1/4"=1'-0", we
would have 1/4"x40, which would equal 10".
If we choose 1/8"=1'-0”, we would have
1/8x40, which would equal 5”. However, if
we chose 1/2"=1', we would have 1/2x40,
which would equal 20", which would be
longer than the 10.5" of the paper. So we
must now choose between the first two.

This has not been an exhaustive discus-
sion of scaling. In using the layout tabs on
the drawing, there is much more to be
learned about this subject. In future issues,
I'll write more about it.

Gil Hoellerich, BSEE, is a for-
mer telephone company
professional and teacher.
He frequently writes about
AutoCAD and related top-
ics. He can be reached at
ghoellerich@nc.rr.com.

Scale 1/4"=1'

Scale 1/16"=1'

Figure 3
Figure 4
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Dimensioning has been a constant in
AutoCAD® for many years now. The new
dimensioning features in AutoCAD 2006
are, however, among the most significant
improvements we’ve seen in a single release
in quite some time… quite exciting!

Too often users are forced to explode
dimensions (a CAD Manager’s nightmare)
to achieve the desired results. With the
new features in AutoCAD 2006, that
should no longer be an issue.  

Extension lines
First we have linetypes that can be

applied to dimension extension lines.  How
many times have you had someone review
your drawings and request that one dimen-
sion line be shown as a center line or hid-
den line?  Of course, these requests nor-
mally come from people who don’t use
AutoCAD and have no idea that this is not
possible. Well, now it is!

In your Dimension Style Manager dia-
log box (Format>Dimension Style) under
the first tab, Lines, you’ll find these set-
tings in the lower left-hand corner. You can
control the first and second extension lines
independently (see Figure 1).  

You will also note another new feature in
the lower right-hand corner of the dialog
box.  Typically you set extension lines to
extend a set distance from the dimension
lines (the lines the houses the dimension
between the arrows).  Now, if you want

your extension lines to be a fixed length,
you can check the box and set the length
(see Figure 2).  

Perhaps you don’t
want all your dimension
lines to have these
properties. For the
exception (CAD
Managers are going to
cringe), simply change
one dimension by
selecting the dimension
and right-click. Then
choose Properties from

your shortcut menu and change it for the
appropriate dimensions.  

Center lines and marks
Previously, our Modify Dimension Style

dialog box contained six tabs.  Now, there
are seven tabs of options. The Lines &
Arrows tab in AutoCAD 2005 has been
broken down in AutoCAD 2006 to a tab
for Lines (just discussed) and a tab for
Symbols and Arrows (see Figure 3).  

In the past we had a choice under the
Lines & Arrows tab to choose a Center
Mark or Line and the size.  Many users
didn’t realize that line was even an option
because you would only see it from the
drop-down arrow.  With the addition of so
many new features, the extra tab had 
to be added. While it’s not an official 
new feature, the Center Marks setting is
now more prominent, which I think is
worth mentioning.  

Radius dimension jog
You may have seen this new feature list-

ed on material you’ve read previously
about AutoCAD 2006 and wondered about
its use. The description listed in AutoCAD
materials and in “Lynn Allen’s Tips &
Tricks” booklet states: “Dimensioning
extremely large arcs can be a problem

Dimensioning in 
AutoCAD 2006
Become acquainted with the many new dimension-
ing features in the latest version of AutoCAD

Figure 1

Figure 3

Figure 2
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when the center point is off the screen;
now you can specify a jog angle to proper-
ly dimension large curves.”

Well, I have another use for it as well,
because I don’t normally have a need to
dimension large arcs.  Since it is made sim-
ilar (in my mind) to a break mark, I want-
ed to try it for showing a distance to some-
thing not on the drawing.  I often have to
give a distance to equipment from a build-
ing for permit offices. The building does
not need to be shown, but the distance
needs to be given.  

The jogged dimension
only works with an arc. So
if you want to use it for
purposes other than
dimensioning an arc, you’ll
need to draw an arc. You
can erase it later.  

When you begin the command, you are
prompted to Select an arc or circle (didn’t
I tell you that you’d need an arc?). After
selecting your arc, you are prompted for a
center local override. This is where your
jogged dimension will go, rather than in
the center of the arc. I just picked any-
where. Then you are prompted to Specify
dimension line location. This is where your
jog point will be. You’ll also have options
available. If you want to add a piece of text
(50 feet from building, in my example),
you can select the Mtext option and add

text. Finally, you are prompted to Specify
jog location. You can see the jog location
move as you move your cursor, allowing
you to visualize where you want the final
jog to be placed. This can be edited later
with grips.  

Command: _dimjogged
Select arc or circle:
Specify center location override:
Dimension text = 92’-3”
Specify dimension line location or 

[Mtext/Text/Angle]:
Specify jog location:

Arc length dimension
Users have needed a

way to dimension the
length of an arc for years.
This AUGI Wish List item
has finally been granted.

To date, there have been many unsatisfac-
tory workarounds that involved listing the
length of the arc and using that informa-

tion to label it. The new Arc
Length Dimension does exactly
what its name implies—it 
places a curved dimension line
from each end point of the arc
and lists the length of the arc as
the dimension text.  

Flip dimension
arrows

I’m accustomed to seeing 
the term “flip” with Autodesk®

Architectural Desktop.  I was a little sur-
prised to see it used to describe a new
dimension feature, but that description 
is apt.   

If you’ve ever needed to move one
dimension line arrow, you’ll love this new
feature. Once again, no exploding is need-
ed. All you need to do is to select the
dimension at the end closest to where you
want the dimension arrow to reverse, or
flip. Then right-click to activate your short
cut menu and choose Flip Arrow. The
arrow will flip (see Figure 9). Imagine that!  

New dimension features
Many of the new features in dimension-

ing may not instantly stand out. If you sim-
ply go through the Modify Dimension
Style dialog box it generally looks the same
even though the first two tabs are differ-
ent. The best way to discover the new 
features in AutoCAD with the 2006

release (and every
release) is take a
cruise through the 
New Features
W o r k s h o p .
Whether you do it
when the dialog
box opens at start-
up or you go to
Help and select
New Features
Workshop, you
will find this a
great tool to famil-
iarize yourself with

the new improvements. Put the new fea-
tures to work for you and make the most of
your investment as well as your time!  

Beth Powell, an AutoCAD
user since R11/DOS, is the
BSD Applications Engineer
for Engineering Design
Systems, Inc. She also
owns CAD Fuel Design, a
CAD service for the petrole-

um equipment industry. Beth is an AUGI ATP
instructor and a former AUGI Board mem-
ber. She can be reached at
allaboutaugi@cox.net.

Figure 4

Figure 7

Figure 8

Figure 9

Figure 5

Figure 6
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The Project Navigator in Autodesk®

Architectural Desktop has enabled a more
effective management system for com-
monly used building details. I have used
third-party software, which worked fairly
well with ADT, but still the coordination of
titles and section marks remained an issue.
The Project Navigator has enabled “hands-
free” coordination from detail cut to detail
placement, including detail number, title,
scale, and sheet number. In this article I
will describe the method our office uses
for effective detail management.

Detail storage
First, a suitable filing/retrieval sys-

tem is required that is accessible to all
users. Most people in the building
industry are familiar with the CSI for-
mat for classifying products, and that is
the system we use, albeit we are still
with the 16-part format. Our details
are placed on the main server with
total access.

Perhaps one of the greatest concen-
trations of detail types is opening details,
found in Division 08 of the old format.
We are a small office with a relatively
simple collection of door details, so we
place all the door details in one file.
They are arranged in the file according to
interior and exterior, and sub-categorized
into head, jamb, and sill. Inside those groups
there are sections for major materials such
as frame materials, door materials, wall
materials, etc. All details are designed for 1
1/2" scale and fit into a precise grid. See
Figure 1 for a sample of a detail sheet.

Format
Second, the format of the details must

be established so that they are drawn in a
consistent manner. We subscribe to the
National CAD Standards (NCS), which
serve as an excellent method of sheet
arrangement, among other things. Our
drawing sizes are predominately 24" by 36"
and 30" by 42". Following the NCS stan-
dards for detail sheets, we are able to
arrive at a detail block size that serves both
sheet sizes satisfactorily. The larger sheets
contain 6x5 details and the smaller sheets
contain 5x4 details. The grid lines are set
on a no-plot layer. See Figure 2.

I have created a series of blocks that fit
the grid and are sized according to scale.
The block is a square that includes 
guidelines for text alignment, title place-
ment, graphic scale placement, and overall
border. All but the graphic scale are on no-
plot layers. All the details are created with-

in this block or multiples of
blocks. (Figure 3) A completed
detail appears as in Figure 4. 

Setup
Third, the files in the Project

Navigator need to be set up.
•  Create a View file in Project

Navigator and then open it
(Figure 5). The Add Detail
View is set up to utilize call-
outs from other Views, but
we will not need this feature
for this procedure. In the
context and content views of

the dialog boxes, uncheck all associated
files. Open the new view file.

• Insert the detail file or files as cross ref-
erences (Figure 6).

• Create and name New Model Space
Views of the applicable details (Figure
7). Give the model view the name that
you want to see in the detail title. Select
the icon in the right margin of the dialog

The Detail Manager
In Project Navigator

Figure 1

Figure 2

Figure 3

Figure 4

Figure 5
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box and draw a rectangle around the
detail block that you have created.

• Save

• Create and open a detail sheet or open a
detail sheet you have already created.
(Figure 8). The sheet name and number
will automatically appear on the sheet file.

• Drag the detail views into the sheet file
in the selected order (Figure 9). The
sheet grid in Figure 9 contains a node at

every grid line intersection. With my
Osnaps set to Node, the default inser-
tion point of the detail is the lower left
corner, insertion is a snap.

• Save
• Go back to the detail view and drag the

drawing titles from the tool palette into
the appropriate location in the detail
views. The title will automatically assume

its correct name and scale (Figure 10).
The gray background with some of the
text indicates that the text is a field, link-
ing the text with other data, and indicat-
ing that its selection is automatic. The
gray background does not plot.

Fields and keynotes

Fields and keynotes are a part of the
database information that form a part of
the Project Navigator system. Fields for

title block information and
drawing titles are the subject
of another article. Keynotes
used for detail annotation are
automatic, based on the NCS
format for drawing notation.
There are options for the
amount of information shown
in a keynote, as shown in
Figure 11. The keynote can
be left as selected, informa-
tion can be added, or the field

may be replaced by common text.
The keynotes in Autodesk Architectural

Desktop 2005 are set for the 16-division
version of the CSI format and are stored in
a database. The database is edited through
MS Access. Detail elements created
through the tool palette or through the
Detail Manager contain attributes that are
linked to the keynote database so that nota-

tion is automatic. Select the
keynote feature from the
tool palette as you would
any other feature. You are
prompted to select a detail
element, then a location for
the arrowhead. Common
leader and text placement
selections follow. The
keynote is placed as Mtext
and is edited as Mtext,
based on the element
selected.

Summary
In the long run this process saves time.

The detail numbering and titling are auto-
mated, reducing errors and minimizing cor-
rection time, if needed. Details are available
to all users and are able to be maintained by
all users through a common source. This
assures uniformity in documentation and
the use of tried and true details.

Final thoughts
When applying this detail method, it

must be remembered that a detail, once
drawn and used on a project, can never be
altered to suit another project. Instead, the
desired detail must be copied and then
modified, creating a new detail.

Because all the Xrefs may not be located
in the same directory, it is best to activate
the archive command before saving all the
drawings to an archival directory or copy-
ing to a CD for remote users.

Chuck Graham is the
Director of Architecture for
DTI in South Carolina. With
more than 25 years of expe-
rience as a licensed archi-
tect, he leads the firm, not
only in architectural work,

but also in ADT and ABS development. He can
be reached at cgraham@dtiplus.com.
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Mates, an option within Placing
Constraints in Autodesk Inventor®, are
very useful. As a matter of fact, without
placing constraints, assemblies just don’t
go together. This article will cover two
main features called Mate and Flush. Both
are within the same tab in the Placing
Constraints dialog box.

First let’s discuss what a constraint is, in
Inventor: Assembly constraints determine
how components or parts in an assembly fit
together. According to Dictionary.com, the
following are a few of the definitions:
1. The threat or use of force to prevent,

restrict, or dictate the action or thought
of others. 

2. The state of being restricted or confined
within prescribed bounds.  

3. One that restricts, limits, or regulates; a
check. 

4. Embarrassed reserve or reticence; 
awkwardness. 

We will focus on the third, one that
restricts, limits or regulates; a check. That
is what the intent is with Inventor—to
restrict or regulate how two parts fit or 
go together.

What is meant by Mate? When placing
two parts together, first recognize that
each part has many faces. Placing a mate
determines how one face from one part is
brought together with one face from
another part. See Figure 1A.

The second feature,
called Flush, is a con-
straint where two sur-
faces are parallel and are
facing the same direc-
tion. See Figure 1B.

That distance or spac-
ing between those faces
can be set to 0 with both
faces touching for Mate,
and the two faces are
parallel with Flush,
which is the default set-
ting. A positive number,
such as .500, sets an
opening between the
two faces with Mate, or
offsets the two faces
with Flush. A negative number, such as -
.125, creates an interference with Mate,
while with Flush, the two faces are off-
set—the opposite as with a positive num-
ber. See Figure 2 for examples.

Now that we have the basics of Mate
and Flush, let’s say you have been using
these constraints for a short while 
and find they don’t constrain parts just the
way you want. Offsetting one part to the
other just doesn’t quite work, and trying
other ways of constraints always seems to
be missing something. What else can you
do? Have you ever tried using a plane ver-
sus using a part surface? This works very
well, but you must consider how you set up
your planes. If you want to Mate several
parts to the middle of one part, and you’re
not very good at remembering what that
center distance was or you forgot where
you jotted that number down, next time
set a plane at the center of the part. The
use that plane to Mate other planes or sur-
faces with.

Following are a few things to consider
when setting up your planes for using with
constraints. I’ve discovered these make
working with constraints and features easi-
er and helps me remember which plane is
with which part.

1. Do not create planes in assembly models.
2. Do create necessary planes in part models.
3. Always try to use existing dimensions to

set your planes, d1/2 or –d1/2.
When you create a plane in the assem-

bly model, they don’t easily identify with
which part they are associated. When they
are defined in the part model, you can
select any feature of the part in the assem-
bly and all of the part is highlighted. This
let’s you know which plane is with which
part. As the planes are constrained, so are
the parts. If you are using centerline
planes, then all the parts are easily con-
strained. You don’t have to remember the
dimensions for each part to set the offset
dimension when defining the constraint.
When working with several parts that need
to be constrained by the center of each
part, planes are an easy solution to setting
up your constraints, whether using the
Mate or Flush constraint. When selecting
the plane, notice which direction the indi-
cating arrow is displayed for each plane,
which will determine if you need a Mate or
Flush constraint.

Now is a good time to suggest some
assembly tips with constraints. When
selecting the first part for defining a con-
straint, select the part that is currently con-
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Aye Matey, Let’s 
Get Together
Fit assemblies together with Mates, an option in
Autodesk Inventor

Figure 1

Figure 2
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strained; for the second part of the con-
straint, select the part that needs to be
constrained. If you need to edit the 
constraint later in your design process, you
will always know which part was 
selected first and which part was selected
second. It does become frustrating when
you get an error message due to some
minor change you make some-
place in the assembly and when
you try to fix your constraint
you don’t remember which part
you selected first and which
part you selected second.

When you have two parts
that need to be mated, such as
the parts in figure 3, there are
several ways to place the con-
straints. One method is
remembering that the clear-
ance where the two parts fit
together is at .010. That means
our mate needs a clearance of
.005 (this will center the parts
with each other). 

However, if it has been sev-
eral days since you started this project, and
you have had many interruptions, you may
not remember that the clearance was set at
.010. You can go to each part and measure
the length and find the numbers or you
could have set a plane down the center of
each part. If you plan your part when start-
ing to design it, you can set one of the
Origin Planes as a center plane.
Sometimes we are in a rush to complete
and don’t always plan that far in advance.
So, you need to create your plane in the
center of the parts. See Figure 4. With the
planes in the center of the parts, select
each plane and, if the arrows are pointing
in opposite directions, use the constraint
for Mate. If the arrows are pointing in the

same directions, use the constraint for
Flush. This aligns the parts center to cen-
ter with each other.

To complete the assembly with the con-
straint for Mate, select the holes of each
part, which highlights the center line, and
apply the constraint. Now the two parts
are centered with each other and the parts
are in line with the holes. If you want to
allow the parts to move about the center-
line of the holes, you are done. If you want

to keep the parts together, select the Flush
constraint and select the top surfaces of
each part and accept that.

When you have completed all your
mates, and have accepted your last mate,
you will notice the Constraint Dialog Box
is still open. To close the dialog box, you
must select cancel, which does not cancel
all the constraints you just set, it only clos-
es the dialog box. Tip: If you are on your
last constraint setting, select OK, which
accepts your constraint and also closes the
dialog box.

This is just the beginning of Constraints
for Mate and Flush. I touched briefly on
using the Mate Constraint with hole cen-
terlines. The Constraint dialog box has
three tabs: Assembly, Motion, and
Transitional. The assembly tab includes
three other Constraints: Angle, Tangent,
and Insert. Each one has their own fea-
tures and benefits. Experiment and see
what works for you, remember to save
before you experiment, and remember
there is always the undo button!

David Keener is a Design
Engineer for SMT
Industries in Sidney, Ohio,
and also an Adjunct
Professor at Edison
Community College in
Piqua, Ohio. He has been

using AutoCAD for 10 years and Autodesk
Inventor for more than two years. He can be
reached at d_keener@smt-ind.com
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Many engineers and techs have tried the
new toys in Autodesk® Land Desktop 2005
and found them lacking. Profiles are less
than perfect and dirt volume calculations
are far from accurate when compared to
the results obtained by the old tried-and-
true (albeit lengthy and time-consuming)
method. Contours are ugly and in the end,
those commands are relegated to the back
shelf, collecting virtual dust. Why have we
been teased with such promising software,
and what, exactly, can one do about it?

The problem, in reality, is not a shortfall
on the part of the software programmers,
but rather a poorly built surface. Let’s face
it—building a surface that perfectly 
represents every nook and cranny of your
design would take forever and a day, right?
So you toss in a few points and maybe 
even some breaklines and call it good. 
The contours may be ugly, but with a little
manual cleanup, you’ve got what you need
for turn-in. 

The reality is that the results obtained
from using surface-based commands are
only as good as the surface upon which
those commands are executed. What fol-
lows is a tried-and-true method for build-
ing an accurate surface from which one
can extract a wealth of accurate data, and
spend more time on the golf course than at
a desk. 

First things first
Paving grades are the heart of any design

surface and LDT 2005 makes it easy. 
To begin, define your alignment by

drawing a polyline, or a series of line seg-
ments and curves at your road centerline.
Then use the ALIGNMENT > DEFINE
FROM OBJECTS command for line seg-
ments and curves, or the DEFINE FROM
POLYLINE command for polylines. 

Next, build a profile. Go to PROFILES

> SURFACES > SET CURRENT SUR-
FACE. Choose the project’s existing sur-
face. Go to PROFILES > EXISTING
GROUND > SAMPLE FROM SUR-
FACE. In this dialog box, left and right
sampling is for profiles left and right of the
centerline. (Note: if your surface only goes
40 feet left of center, and you choose 50
feet left in this dialog box, you will get an
error at the command line.) Go to PRO-
FILES > CREATE PROFILE > QUICK
PROFILE. Make sure the start station in
this dialog box is the beginning station of
your alignment. If you want left and right
profiles, toggle the check box under profile
creation parameters.

Now choose a location for your profile.
It really doesn’t matter where you put it, so
long as any plan view linework is far
enough away so as not to show up in the
profile viewport of a p&p sheet. After
choosing a location, notice the question at
the command line. Choose NO if you have
other profiles that you want to keep.

Now that you have an existing 
grade profile, it’s time to build a design
grade profile. Go to PROFILES > 
FG CENTERLINE TANGENTS > 
CREATE TANGENTS. Follow the
prompts at the command line to lay in your
design grades. 

Once your design grade is complete, it’s
time to define it so that the data associated
with the profile will be available to other
parts of the LDT program. Go to PRO-
FILES > FG VERTICAL ALIGN-
MENTS > DEFINE FG CENTERLINE.
Pick a point on the first tangent that is
close to the beginning of that tangent.
Select the remaining tangents and/or verti-
cal curves. You have just created data that
will be used to build your surface. Now
complete the same process for all roads in
your project.

Point generation
Open the drawing in which your design

surface will be built. Set an alignment cur-
rent by going to ALIGNMENTS > SET
CURRENT ALIGNMENT. Position the
plan view of the alignment in the center of
your screen. Go to PROFILES > FG
VERTICAL ALIGNMENTS > CREATE
COGO POINTS. In the dialog box, enter
stations for curb returns, curve PCs and
PTs, and vertical PIs. Since you can only
enter two stations at a time, along with an
increment length, you may have to repeat
this command several times depending on
the length and complexity of the align-
ment. (Note: “Point Description” in this
dialog box refers to the Description Key
that will be used during point generation.) 

Once you have created points along all
alignment centerlines, it’s time to move the
points to their appropriate locations for
surface construction. Go to POINTS >
EDIT POINTS > MOVE. Select all points
along a tangent (curve points must be
moved individually) and select the 
node of any point as the reference point.
Select the perpendicular point along the
back of curb line in your drawing that is
adjacent to that point. (See Figure 1.)
Points that need to be on both sides, such
as at vertical PIs and curve points, should
be copied to the adjacent side using
POINTS > EDIT POINTS > COPY.

Breaklines
Breaklines are critical to accurate sur-

face modeling. Before beginning breakline
construction, make sure all design points
are at 3D elevation. Set the current layer
to “0” and make the color yellow. 

First, draw breaklines, using the
AutoCAD 3d polyline command, between
all points on straight line tangents. Next,
go to a curve. Draw a 3d polyline between

Accurate Surface
Modeling
A well-built surface helps you get the most
from Autodesk Land Desktop



the points at each end of the
curve. (See Figure 2.)  

Next, draw another 3d 
polyline from the first point to
the midpoint of the first 3d
polyline, then to the second
point. Click on the new 3d poly-
line, and use the grip at the
midpoint to stretch the polyline
out until the ends are tangent to
the ends of the curve. (See
Figure 3.) You can tell that the
ends are tangent when the poly-
line changes color as it lays over
the curve.

Next, go to TERRAIN > 3D
POLYLINES > FILLET 3D
POLYLINE. Follow the
prompts at the command line.
Note that if your radius is 30
feet at the face of curb, and
your curb is 8 inches, then 
the radius at the back of 
curb is actually 29.3 feet.
Additional vertices should be
set at a value of one (1). (Less
than this, and your surface tri-
angulation will become too
complex and bog down your
processor). Repeat this proce-
dure for all curves. 

Subgrade 
breaklines

Now that you have top of
curb breaklines, you need to
create breaklines for the sub-
grade surface features within the
project paving. Fortunately, this
is very simple to accomplish.

Go to TERRAIN > 3D
POLYLINES > CREATE
CURB. You will be prompted
to select a polyline. Select one
of the top of curb polylines you
created earlier. Select the side
toward the centerline when
prompted for the offset 
side. If you are using 8-inch
curbs, put in an offset distance
of 0.67, and so on. When the
elevation prompt appears, 
type “D” and press enter. This
is to let the program know 
that you want to create a line that 
is uniformly up or down from the current
polyline. Most subgrade is one foot 
below top of curb (consult your city stan-
dards to be sure). Type “-1” to let the pro-
gram know you want to drop one foot.
Repeat this for all 3d polylines that you
created earlier.

Surface tie-in
Now that you have completed break-

lines for the paving, you need to create
breaklines along the project boundary.
These lines will make your design surface
attach to the existing surface at the loca-
tions where grading will stop in the field.
This is important, as it will not only help

acquire accurate dirt numbers,
but also allow you to design sur-
face features that properly drain
and tie back in the way they
should in the field.

Draw a polyline around the
entire project boundary, with the
exception of locations where
paving may terminate in anticipa-
tion of future development. Next,
set the existing surface current. Go
to TERRAIN > SURFACE
UTILITIES > OBJECT PRO-
JECTION. Select the polyline you
just drew. When prompted, you
may put a unique layer name for
this line, or just leave it as is. (Note
that you are asked whether or not
to erase the old projection layer. If
you say “yes,” all objects on the
projection layer will be erased.)
The new polyline on the projection
layer has now been created to rep-
resent existing surface features at
the boundary.

Go to TERRAIN MODEL
EXPLORER. Choose your
design surface, and define all of
these 3d polylines as breaklines
for that surface. There is really
no need to include your points in
the surface, as the breaklines
already have those elevation
points covered.

Completing the 
surface

Technically, you now need only
draw a polyline around all these
things and define it as the surface
boundary through Terrain Model
Explorer. Then build the surface
and you are done. In reality, you
may want to place rectangular
breaklines for building pads, 3d
polylines for swales, etc. However,
the work you have done to this
point will provide you with a sur-
face that will make all those neat
little commands come to life. One
note of advice: use composite vol-
umes when calculating dirt, and
use “1.10” for a 10 percent com-
paction factor, not “10.” Good luck!

A. L. Pierce is a civil design
technician and production
manager for Sheffield
Engineering, P.L.L.C. of
Oklahoma City, Oklahoma.
He can be reached at 
cadhead@cox.net.
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Figure 3: Stretch 3d polyline via midpoint

Figure 1: Move points to back of curb

Figure 2: Draw a 3d polyline between points
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I’ve been searching through the archives
of my mind to find some of the hidden
secrets of AutoCAD® that are long forgot-
ten. I’m not resurrecting these secrets for
posterity purposes, but to shed light on
some old lost productivity techniques that
are still useful with today’s release.

Super Groups – productivi-
ty legends

The GROUP command has been
around for a long time. It allows you to
group objects so they act as one item. They
will move as one unit as long as they are
grouped. This command is most useful for
items you need to move together frequent-
ly but you don’t need to make into a block
(though if you use them with blocks it gives
you the ability to essentially have explod-
able nested blocks).

Grouping objects is more flexible 
than blocking, because you can easily 
turn the grouping feature on or off.
However, it does not have the same mem-
ory advantages as blocks for multiple
copies of objects.

A group is a named selection set of
objects. Unlike unnamed selection sets,
groups are saved with the drawing. Group
definitions are maintained when you use a
drawing as an external reference or insert
it in another drawing. Until you have
bound and exploded external references or
exploded blocks, however, you cannot
directly access groups that have been
defined in an external reference or block. 

When you create or edit a group, you
can specify whether it is selectable. If a
group is selectable, selecting one of its
members selects all members in the cur-
rent space that meet the selection criteria
(for example, members on locked layers
are not selectable). The ability to select
groups is also affected by the PICKSTYLE
system variable. When PICKSTYLE is off
for group selection, you can individually
select group members. 

An object can be a member of more

than one group. You can list all the 
groups to which a selected object belongs
by using the Find Name option in the
Object Grouping dialog box. Highlight 
all the members of a specified group 
with the Highlight option. Group mem-

bers are numerically ordered and can be
reordered. Reordering may be useful in
some batch operations on objects or when
it’s important which object is “on top” for
display purposes. 

Creating groups
When you create a group, you can give

the group a name and description. If you
copy a group, the copy is given the default
name Ax and is considered unnamed.
Unnamed groups are not listed in the
Object Grouping dialog box unless you
select Include Unnamed. 

If you choose a member of a selectable
group for inclusion in a new group, all
members of that selectable group are
included in the new group. Selectable

groups can also be highlighted, making it
easy to track and find them for revisions.

Selecting Groups
You can select groups by name at the

Select Objects prompt. If the PICK-

STYLE system variable is set to 1 or 3 and
you select any member of a selectable
group, AutoCAD selects all group 
members that meet the selection criteria.
You can also toggle group selection on 
and off by pressing CTRL+H or
CTRL+SHIFT+A. 

All members of selectable groups are
also selected when you use object selection
cycling. Selecting an object that is a 
member of more than one selectable
group selects all the members of all the
groups that contain that object. To select
groups for editing with grips, use the
pointing device to select the group at the
Command prompt. 

Hidden Secrets of
AutoCAD
Try some of these time-tested techniques

Figure 1: You can track and name each group you create.
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Editing groups
At any time, you can

add or remove group
members and rename
groups. You can also
copy, mirror, and array
groups. Erasing a
group member deletes
that object from the
group definition.
When a group member
is included in a deleted
block, the object is
deleted from the draw-
ing and also from the
group. If deleting an
object or removing it
from a group leaves
the group empty, the
group remains defined.
You can remove the
group definition by
exploding the group.
Exploding a group
deletes it from a draw-
ing. Objects that were
part of the group
remain in the drawing. 

You can alter the
group’s member order
(the order in which 
the objects were
selected), its descrip-
tion, and whether it is
selectable. You can

reorder group members in two ways:
either change the numerical position of
individual members or ranges of group
members, or reverse the order of all mem-
bers. The first object in each group is num-
ber 0, not number 1.

Summary
Groups give you the flexibility to track,

order, reorder, name, and rename the orig-
inals and copies of groups without affect-
ing and updating other groups. This gives
you far more flexibility manipulating
objects than using blocks. 

If you haven’t tried using groups, I hope
you’ll take some time to explore this hid-
den productivity treasure. Until next time,
don’t close that new dialog box!

Matt Murphy, chair of the
Autodesk Training Center
Advisory Board (ATCAB), is
an Autodesk Certified
Instructor (ACI). He teaches
AutoCAD productivity
seminars at ATCs, Autodesk

University, AUGI CAD Camps, and private
companies. He can be reached at matt.mur-
phy@ACADventures.com.

Figure 3: When you create a copy of a group the new group or
copy is unnamed.

Figure 4: When you turn
the group off with a
CTRL-H or CTRL-SHIFT-A
and you can then move
the individual objects.

Figure 5: Once you
rearrange the objects
turn the group back on
with a CTRL-H or CTRL-
SHIFT-A and you can
move the assembly
again like a Block.

Figure 2: Unlike Blocks, Groups can be highlighted to show their
location in the drawing.
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Getting to the forums
Member Login -> http://www.augi.com/login/login.asp -> 

Enter your E-mail address and Password -> 

Click the Login button (Note the two tick boxes on this page
“Remember my password” and “Enable Automatic Login,” plus
the two links if you experience any difficulties with logging in
“Have you forgotten your password?” and “If you have problems
logging in, please contact Member Services”).

You should now find yourself on the Home page ->
http://www.augi.com/home/default.asp

From the menu bar along the top (see image below) you have
two means of access via either the “Product Communities” or
“Forums”

1. Product Communities will take you here ->
http://www.augi.com/communities/default.asp

Currently there are two Product Communities, Autodesk Revit
and AutoCAD. More are definitely in the works and will be
launched once the relevant community team has finished all of
the behind-the-scenes development work necessary to bring a
Product Community online.
• Revit Community -> http://www.augi.com/revit/default.asp
• AutoCAD Community -> http://www.augi.com/autocad/default.asp

I highly recommend that you browse these pages and check
back there at least once a month to see what is new and updated
(the community team members update their respective pages at
least once a month, so please take the time to support their 
efforts by browsing the content). I believe you might be 
pleasantly surprised by the information available in this section,
though for the scope of this article I will be concentrating on the
next area, the Forums.

2. Forums will take you here ->
http://www.augi.com/forums/default.asp

Note the links in the navigation area on the left-hand side (see
image below), there you will find useful information relating to
the forums. Also, take the time to read the information given on
http://www.augi.com/forums/default.asp

I recommend you also take the time to browse that page at least
once a month, as new and updated information relating to the
forums is posted there for the benefit of everyone.

Enter the forums by either clicking the “Go Directly to
Forums” link (as highlighted above) or by scrolling to the bottom
of page http://www.augi.com/forums/default.asp and clicking the
“Go to AUGI Forums” button (see image below).

What awaits you inside the forums
You should now be within the AUGI Forums ->

http://forums.augi.com/index.php?
The AUGI Forums image shows the main page, with the forum

menu bar highlighted along the top. Note how Autodesk products
have been grouped into relevant industry areas (working from 
top, downwards):

Collaboration consists of sub-forums for DWF Composer,
Buzzsaw.

AEC consists of sub-forums for Architectural Desktop, Building
Systems, Architectural Studio, Revit.

General Design consists of sub-forums for AutoCAD,
AutoCAD LT, Raster Design, Autodesk VIZ.

The Forums, AUGI’s peer-to-peer

web-based support group for

Autodesk products, are continually

developing and growing to meet

the needs of members. Here’s a

get-started guide

Welcome to the 
AUGI Forums
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GIS consists of sub-forums for Land Development Desktop,
Survey, Map, Civil Design, Civil 3D, MapGuide.

Manufacturing consists of sub-forums for Inventor, Mechanical
Desktop, AutoCAD Mechanical, AutoCAD Electrical.

In addition to the above, you will find forum areas for –
AUGI Training Program (ATP) refer to The AUGI Training

Program (ATP) pages http://www.augi.com/education/
default.asp?page=728 found under the Education area of the
AUGI website for more details on what ATP has to offer and how
it uses the forums as a part of its program.

AUGI Publications – AUGIWorld is our official bi-monthly
magazine, refer to AUGIWorld page http://www.augi.com/
publications/default.asp?page=63 found under the Publications
area of the AUGI website for more details on this resource.

AUGI HotNews is the official monthly newsletter sent to all
AUGI members (who have elected to receive it) via e-mail. Refer
to Hot News page http://www.augi.com/publications/
hotnews.asp?page=64 found under the Publications area of the
AUGI website for more details on this resource.

The sub-forums AUGIWorld and Hot News are both divided
into two areas –
1. AUGIWorld http://forums.augi.com/forumdisplay.php?f=30

and Hot News http://forums.augi.com/forumdisplay.php?f=31 are
for comments and/or discussion on articles that have been pub-
lished in the relevant publication (Note: within these forums
you cannot post a new thread; you can post a new message with-
in threads that have been placed there in advance by Site
Admin staff).

2. AUGIWorld Feedback http://forums.augi.com/
forumdisplay.php?f=122 and Hot News Feedback
http://forums.augi.com/forumdisplay.php?f=123 are for dis-
cussing content, ideas, suggestions, and general feedback relat-
ing to the relevant publication.
CAD Management consists of sub-forums relating to the gen-

eral areas that typically fall under the responsibility of an in-house
CAD Manager.

Forum General consists of sub-forums that have a broad feel
about them, and do not really fit into any of the other forum areas. 
• Career Corner is made up of two forums: Job Offers

http://forums.augi.com/forumdisplay.php?f=214 and “Job

Seekers http://forums.augi.com/forumdisplay.php?f=213 this is
where AUGI members can post job request (looking for work)
and job offer (employers looking for staff) posts. 
When posting within those two forums, please follow the
Career Corner Guidelines http://forums.augi.com/
faq.php?faq=vb_augi#faq_new_faq_item6.

• Coffee without CAD is where AUGI members are free to talk
about non-CAD related topics, enter light-hearted chit-chat,
make friends, relax, and have a little fun away from the daily
stress of work (in fact ‘work’ is considered a four-letter 
word within this forum). Please, remember to keep things
polite and professional when posting in this forum; though
things are definitely more relaxed there, the AUGI Forum
Guidelines still apply.

• Forum Tips & Tricks enables Site Admin staff and forum
Moderators to post helpful tips relating to getting the most out
of forum features. (Note: within this forum you cannot post a
new thread, nor post a new message within a thread).

• New Forum User is where new users can experiment to
become comfortable with the forum-posting editor and learn
how to interact with the forums. It is not for technical questions
relating to Autodesk products.

• Site Feedback – allows you to post ideas and suggestions about
how to improve the AUGI website. 

• Forum Feedback – permits you to post improvements or new
features you would like to see on the Forums.

• Ask the BOD enables you to post questions, concerns, or
requests about AUGI programs, projects, or events. If you are
unable to find answers elsewhere on the website, use this
resource.

• International consists of sub-forums that are broken down by
(non-English) languages. This area is where AUGI members
can post in their native tongue.

• Programming consists of sub-forums relating to the main API’s
that Autodesk offers as a means of customization and develop-
ment for their products.

General information about the forums
If you are new (or relatively new) to the forums, I recommend

that you take the time to review the following pages. 
AUGI Forum Guidelines

http://forums.augi.com/faq.php?faq=vb_augi
User Maintenance

http://forums.augi.com/faq.php?faq=vb_user_maintain
General Forum Usage

http://forums.augi.com/faq.php?faq=vb_board_usage
Reading and Posting Messages

http://forums.augi.com/faq.php?faq=vb_read_and_post
The above can be found by following the FAQ link on the

forum menu bar.
Before you start posting in the forums, you should pay a visit to

your Control Panel, accessed via the appropriate link found in the
forum menu bar (see image on page 24). 

Work through the options available there for setting personal
information that relates solely to the forums, and settings that
allow you customize the forum environment to your own person-
al liking. The options, settings, and their meanings are covered
extensively within the links given above.

Following are additional Control Panel options that have been
covered in the Forum Tips & Tricks forum.

Turning on WYSIWYG Text Editor
http://forums.augi.com/showthread.php?t=15819

AUGI Forums
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Setting your clock to local time
http://forums.augi.com/showthread.php?t=16727

AUGI Calendar. By clicking the
Calendar link found in the forum
menu bar you will be taken to
http://forums.augi.com/calendar.php?
From here you can view either the
AUGI Calendar or the LUG Calendar.
To switch between the two, scroll to
the bottom of the page and use the
Calendar Jump drop down box (see
image below).

You also have the ability to add an event to either calendar by
using the Add New Event links, which can be found at the top and
bottom of the page (see images below).

Members List. By clicking the Members List link found in the
forum menu bar you are taken to http://forums.augi.com/mem-
berlist.php? From here you can see all AUGI members who have
posted at least once in the forums. The Members List can be sort-
ed by User Name (alphabetically), by number of Posts made, or
by level of forum Reputation points (see image below).

The Members List also has a Search Members facility
http://forums.augi.com/memberlist.php?do=search that allows
you to search for forum users according to information you supply
in the various option fields available.

Search by clicking the Search link found in the forum menu bar,

you are taken to http://forums.augi.com/search.php? This is the
forum main search page, and really should become your best
friend and resource here.

Why? The AUGI forums are an ever-expanding database of
answers, information, solutions, tips, etc. that cover a wide variety
of Autodesk products that we all use in our daily working lives;
there is a good chance that any difficulty you are experiencing has
already been resolved, and the answer is simply awaiting you with-
in the forums.

The forum Search page has a variety of option fields that allow
you to refine your search criteria, thus returning more applicable
information.

Following are a couple of useful forum search hints that have
been covered in the Forum Tips & Tricks:

Forum Searches using short words and abbreviations
http://forums.augi.com/showthread.php?t=8154

Fast searches for posts within the last “X” days
http://forums.augi.com/showthread.php?t=4445

How to post a new thread
With your question in mind, you now need to decide which

forum is the most relevant one in which to post your message (as
a New Thread). A few simple questions such as the following
should help you make the right choice:

What Autodesk product am I currently experiencing a problem
with? Click the relevant Autodesk product link on the forum main
page, this will take you into the forum area for that product. You
will now see sub-forums that relate to that particular product (see
images below).

Revit forum main page

AutoCAD forum main page

Top of page Bottom of page

Remember the
forums are all
about AUGI

members helping
AUGI members
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What version am I experiencing the problem with? Click the
relevant version link, which will take you into the forum for that
version. You will now see sub-forums that relate to that particular
release (see images below).

Revit Building Support forum page

AutoCAD forum page

What sub-category of that version am I experiencing the prob-
lem in? Click the relevant link, which will take you into the forum
where you will post your question (see images below).

Revit Building – General forum page

AutoCAD General forum page

For the purposes of this article, I removed from these images
the Currently Active Users; number of forum users browsing the
particular forum; and their forum user names. Ordinarily, such
information will be available to you during a forum visit.

At first glance, this might appear to be a long-winded proce-
dure to get to where you need to be, but, in truth, it takes only a
few seconds to arrive at the relevant forum. 

Also, with this example, I have shown so-called “worst case sce-
narios” where you have to drill down a few levels. You will find
other forum areas that do not require such deep navigation in
order to get to the relevant forum.

There are many important reasons to try your best to post in the
most relevant forum, a couple of which are listed below.
• Forum users (the people who will hopefully be able to answer

your question) tend to monitor and quickly scan the Autodesk
product forum(s) they have an interest in, so, by posting in the
appropriate product forum, you are greatly increasing your
chances of receiving the most relevant help from people that
use that particular product in their working life.

• As I said earlier, the forums are a searchable database of infor-
mation, and, like any database, the information stored inside is
only as good as the information entered in the first place.
Placing information in the most relevant and appropriate place
will enable other forum users to get the most from the Forum
Search facilities. 
Remember the forums are all about AUGI members helping

AUGI members (peer-to-peer support).
If you do post a thread in a less-than-appropriate location, no

worries, as you will generally find a forum Moderator will come
along and move the thread to a more pertinent place. Please do
not view this action as a bad sign, the Moderator is only fulfilling
part of his or her job, which is to help keep the forums tidy and
functioning as best they can. If you do find a thread of yours has
been moved, you should find a link (called a redirect) which has
been left by the Moderator in the original location; simply click-
ing that link will take you to your thread in its new forum location.

When you are ready to post your question as a New Thread
within the forum you have chosen, click the “New Thread” button
located in the upper left corner (see image below).

The forum-posting editor opens (see image next page. Note:
this screen capture shows the “Enhanced Interface – Full WYSI-
WYG Editing” option). Now you enter your detailed question and
supporting relevant information.

Enter a suitable Title. Try to give it some real relevance to the
question which you are about to ask, as doing so greatly helps the
whole process, and definitely benefits you as most forum users
will generally pay more attention to a Title that makes clear the
problem, rather than something ambiguous such as “I need help”
or “I have a question”.

Enter your question into the main area of the editor; try to give
as much information as possible relating to the problem you
require help with. The more relevant the information you supply,
the greater your chance of receiving back accurate and useful
information that will either answer your problem directly, or at
least guide you in the right direction. 
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Before submitting the New Thread to the forum, look at using
the Spell Check and Preview Post buttons. Doing so will enable
you to catch any spelling mistakes or spot any other formatting
issues you may want to correct before submitting your question.

Once you are happy with everything, its time to click the
Submit New Thread button.

Your question is now posted in a New Thread within the forum
you chose. Sit back, grab yourself some coffee and wait patiently
for other forum users to arrive and read your post. The complex-
ity of your question will sometimes greatly affect the amount of
time you have to wait before you start seeing responses posted. If
you are lucky, you may receive the correct answer almost immedi-
ately. On the other hand, your question may prompt forum users
to request further information or clarification of the problem as
they attempt to help you find the answer.

Whichever way it goes, please be patient and extend forum
users the time they require to help you, if they can. Please, always
try to remember that the other users have regular jobs just like
you and no one is being paid to provide answers; we are all just
there trying to help one another the best we can.

What if I want to post an attachment (a file) or include some-
thing like a poll (gather feedback and opinions) in my New
Thread? Before you click the Submit New Thread button, scroll
down beneath the posting editor and review the Additional
Options area (see image below).

How to post a reply to a message
• Go to the forum where the thread is located.
• Click the thread’s link to view.
• Click the Post Reply button located in the upper left or lower

left corner OR click the Quote button located in the lower 
right corner of the actual message you want to reply to (see
image below). 
Using any three of those buttons will open the forum-posting
editor as described above. To post your reply, follow the same
procedure as given for creating a New Thread.

• If you do not need the forum-posting editor, and only require a
plain text editor to post a quick response, look at using the
“Quick reply to this Message” button located next to the Quote
button (see image below).

Summing up
Hopefully, the above has provided you with a good idea of 

what the AUGI forums have to offer and a basic understanding of
how to use them. Within this article I have not had the time or
space to cover a lot of the more advanced forum features and
tools, such as:
• Editing your own posts.
• E-mail notification.
• Rating a thread (currently important when dealing with the

Autodesk product Wish List forums).
• Sending E-mail or Private Message (PM) to forum users.
• Subscribing to a forum or thread.
• Using special codes and tags within forum posts.
• Using the forum reputation tool.

I would like to, therefore, encourage you to follow the links
which I have provided in this article and read up on the things that
I have skipped.

Also go to the New Forum User http://forums.augi.com/
forumdisplay.php?f=47 area and experiment further with the
forum-posting editor; click the different links and menu items
available; look at and try out the options and functionality which
they offer.

See you on the forums soon! And please do not forget that if
you require any assistance or help using the forums, you have only
to ask. I believe you will be pleasantly surprised by how many of
your fellow users will be more than willing to lend a hand and
guide you in the right direction.

Mike Perry is Civil/Structural Senior CAD Technician
in the bridges and special structures division of
Faber Maunsell, a multi-discipline engineering con-
sultancy in the UK. He has been using AutoCAD for
10 years. Mike is on the AUGI Board of Directors and
can be contacted at mike.perry@augi.com.
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Fast…Easy…Efficient
Welcome to a new, easier way to get more information about the
companies, products, and services featured in this issue of AUGIWorld.
Here's all you need to do:

Go to www.augi.com/adinfo. Here, you can:

➤ send personal emails to the companies found in this issue or 
previous issues

➤ visit the websites of the companies featured in AUGIWorld

➤ send a general email requesting more information from any of 
the companies mentioned in this and other issues of AUGIWorld

Communicating with software developers has never been easier! 
At www.augi.com/adinfo, you’re a click away from any 
company featured in AUGIWorld.
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Why is CADWorx one of the 
fastest growing AutoCAD®-based
plant design suites on the market?
Because it has all the tools to produce 
intelligent plant designs, including:

• Piping
• Steel
• Cable trays/Ducting
• Collision detection
• Equipment
• Bills of material
• Isometrics
• Flow schematics
• Instrument loop diagrams
• Bi-directional links to analysis programs
• Walkthrough and visualization

CADWorx delivers!
Contact us to find out how you can improve
your design efficiency.
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When I first started this column, I said
we would discuss the good, the bad, and
the ugly. In this column, the names have
been changed to protect the innocent. 

Autodesk has been around for more
than 20 years now, and several technolo-
gies and new products have been intro-
duced. Believe it or not, at one point the
introduction of “edit text” in AutoCAD®

rocked people’s worlds! Things like
XREFs, Paperspace, and Sheet Sets
changed the way people worked. One of
my all-time favorite AutoCAD enhance-
ments is DIMASSOC value 2, introduced
in 2004. Check it out. Products such as
Inventor and Revit have simply changed
the engineering landscape.

If one dog year equals seven people
years, then CAD years are even worse. A
five-year-old CAD product is clinging to
life. As a result of the onward and upward
march of technology, there are many CAD
methodologies in use. Some companies
settled into a groove (or “rut” as the case
may be) early and never changed. To get
the best out of CAD and people, the group
mindset must periodically be changed in
concert with new CAD technologies.

Three categories of CAD
There is an old saying: There are three

kinds of people in the world, those that
make things happen, those that know
what’s happening, and those that ask 
“what happened?”  Based on that, I have
determined that there are three basic
CAD mindsets.

The first mindset I’ll call “The Classics.”
This group works in model space only, for-
mat blocks are scaled to 48x at insertion,
dimscale is set to 48, and plot scale to
.020833 (1/48). You have recently been
heard to say, “Why can’t I buy 3.5” floppies
any more?”, “XREFs and Paperspace
suck!”, and “That’s not the way we do it
here.” Is this jargon part of your daily
mantra? If so, slower traffic please keep
right. In the sense of a classic car, this
serves as basic transportation when prop-
erly maintained, and you do have to know
where to get parts for it, but today it is just
plain foolish to get into the fast lane and try
to roll with the big dogs.

The second mindset I’ll call the “Light
Blue Collars.” Most companies fall in this
category. Management understands the
benefit of CAD and supports it. As a result,
these folks have made moderate advances
in technology. There is analysis supporting
their software choices. They use the appro-
priate vertical software and they upgrade
when they see the benefit. Many people in
the company understand and use the
advanced features of the software.

Mindset three I’ll call the “Creative
Class.” They understand that to be com-
petitive, they have to maintain a techno-
logical edge, thus, THEY HAVE A
TRAINING BUDGET! They know what
their software is capable of and make a
concerted effort to apply it appropriately.
They envision major and minor ways that
software can be made better and are not
afraid to ask for them. They set examples
for other CAD groups to follow.

Toto! Why are we still in
Kansas?

I am a consultant to a well-established
(way before CAD) company making signifi-
cant modifications to a large piece of exist-
ing hardware (I’m a mechanical guy). I am
confident that the end product will be
excellent because it is a good team of peo-
ple. It involves hundreds of sheet metal
parts and complex curves. Autodesk
Inventor® sheet metal is the perfect tool for
the job. This company’s only crime (appar-
ently I have declared myself judge and
jury!) is using obsolete CAD methodology.

Most of the senior engineering staff are
early CAD converts, but are stranded on a
technological plateau in the AutoCAD 14

era. The company standard is AutoCAD
2D (2002), but the method is pure R14.

What they do pushed paper drafters to
the limits in the 1970s. I know because I
was one of those guys, but not for this com-
pany. Before CAD, things got done by
throwing hundreds of people on a job and
running many parallel efforts. The effi-
ciency of CAD has reduced the number of
parallel efforts by enabling a typical person
to manage much more information.

I called on this company in my days as
an Inventor Application Engineer (CAD
sales guy), unsuccessfully, I might add.
What I can see now from the inside is that
aside from not upgrading their software,
they have not upgraded their methods of
operation in 30 years. I understand now
why their company mindset would not
consider Inventor.

The big flip-flop
One major mistake a company can make

is to use CAD in an unorthodox manner in
order to avoid modifying their established
workflow. What they should do is adjust
their workflow to take advantage of new
CAD technology.

The point I am trying to make is that a
company can labor for years under a “false
economy.” They believe it is too expensive
to change, to upgrade software, and to
train people. Things appear to be running
smoothly to them, but in truth they are
wasting a lot of money maintaining the sta-
tus quo.

Economic times are getting tougher and
tougher. It is common for a company to
reduce operational costs to compete, or
even survive. If your company is still one of
the “Classics,” you could become a hero by
putting together a comprehensive plan to
bring them into the 21st century. If you
can demonstrate how to spend less money
and improve your product, you might not
get voted off the island!

David Kingsley served from 1999-2004 on
the AUGI Board of Directors and is the
Director of Electrons at CADPlayer Web
Courseware. He can be reached at 
djkingsley@cad-tv.com
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Looks like training. 
Feels like empowerment.

Autodesk University training is one of the most effective ways for your company to 
realize a quick return on its investment in Autodesk technology. The professional-
grade training, industry knowledge, and business contacts you’ll gain at AU are sure 
to make you the authority on productivity of your organization.

Autodesk University, where ideas are encouraged, cultivated, and realized.

Register by October 8 and save up to $500.
Visit  www.autodeskevents.com/au2005 or call 888-371-1722. 

Autodesk University Annual User Conference and Exhibition
Walt Disney World Swan & Dolphin Resort, Orlando, Florida, U.S.A.  November 28 – December 1, 2005

© 2005 Autodesk, Inc. All rights reserved.



Buying the right software is the first step. Like 
other highly successful companies, you can increase 
the return on your investment by calling on
IMAGINiT’s full range of professional services to 
boost productivity…and your competitive edge.

With a complete line of design and engineering 
solutions—including the AutoCAD® family of products
—IMAGINiT focuses on your business success. And 
with a global reach of more than 80 branches, we’re
there to help you open up new design possibilities 
and revenue streams.

Look to the professionals at IMAGINiT for:
• Technical training
• Design-process implementation 
• Software development
• Consulting on business-critical requirements
• Data and document management
• Asset management to increase revenue potential
• 3D visualization services

Choose IMAGINiT as your partner and turn today’s 
challenges into tomorrow’s profitable solutions. Let 
us be the missing link in your company’s evolution.

United States: 800-356-9050   • Canada: 800-461-9939   • www.rand.com/imaginit

Knowledge, Experience, Linking Design and Technology

As your 
tools evolve, 

so should 
your training 

and skills.

As your 
tools evolve, 

so should 
your training 

and skills.

Official AUGI CAD Camp Host: Chicago Seattle
Cleveland Boston
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